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READ ME
It is strongly recommended to familiarize yourself with this workflow before using ArcGIS Online/Collector on an incident. Take your time going through the document start to finish. View videos before starting this document &/or throughout the process.
This document is not just a tutorial. It provides recommended steps for managing your incidents FIMT geodatabase, Other geodatabase, AGOL feature services and maps, and use of the Collector App. The workflow will help you keep data in sync between the different platforms. The templates you use while practicing this workflow will be used on an actual incident too. You will be introduced to key AGOL & Collector concepts. Self-motivation is required, if you don’t understand something, google it and dig deeper.
*When you are using this workflow as a tutorial, you need to make a ‘practice’ FIMT incident and make up your own fire data.


[bookmark: _Ref397937184][bookmark: _Toc410996247]Introduction
[bookmark: _Toc410996248]Objective
This is a wildland fire mapping pilot-project that utilizes ESRI’s ArcGIS Online (AGOL), a web mapping platform, and Collector (10.2.7), an application for mobile devices (iOS 7 or later and Android 4.0 or later). The workflow in this document covers the steps on how to use a Fire Incident Mapping Tool (FIMT) geodatabase (gdb) with AGOL. 
What this technology brings to the table:
· Offline Collection: The ability to view maps and collect data when there is no cellular service or WiFi. When a device establishes connectivity, changes in a map can be sent and received (synchronization/sync).
· Real-Time Data Sharing: Users of Collector will be able to share their data in a real-time manner in connected environments. This will be beneficial for the GIS Specialist (GISS) managing the maps & data and other Incident Management Team (IMT) members will benefit from being able to view these near real-time updates.
· Security: Permissions will be given to only select individuals to view and add spatial data to maps. AGOL accounts are required to use Collector and can be issued when needed.
· Paper Map & Printing Reduction: Being able to view the most up-to-date maps on a mobile device reduces the amount of paper maps needed.
This document contains a suggested workflow. The goal of this process is to develop a secure and seamless way to share maps with the different types of viewers & users (IMT personnel vs Public). It is also a workflow to allow the GISS to organize and manage: incoming data (QA/QC), the FIMT gdb, users, and permissions.


[bookmark: _Toc410996249]Description
There are two main parts to this document:
[bookmark: _Toc398618620][bookmark: _Toc410710811][bookmark: _Toc410996250]Getting started with AGOL & Collector - Section 2 & Section 3
· If you are not proficient with AGOL &/or Collector this is where you need to start. Watch the videos and read up on AGOL and Collector capabilities and processes.
[bookmark: _Toc398618622][bookmark: _Toc410710812][bookmark: _Toc410996251]Workflow - Section 6
· Here you will go through the process of how FIMT can be integrated and managed with AGOL and Collector. 

[bookmark: _Toc410996252]Target Audience
GIS Specialists on wildland fire incidents

[bookmark: _Toc410996253]Requirements
[bookmark: _Toc398618318][bookmark: _Toc398618625][bookmark: _Toc410209858][bookmark: _Toc410710815][bookmark: _Toc410996254]Need to be an experienced user of ArcMap
· [bookmark: _Toc398618319][bookmark: _Toc398618626]ArcMap version 10.1 or higher
[bookmark: _Toc398618320][bookmark: _Toc398618627][bookmark: _Toc410209859][bookmark: _Toc410710816][bookmark: _Toc410996255]Experienced using the Fire Incident Mapping Tool (FIMT)
· Download the tool and documentation here[footnoteRef:1] [1:  gis.nwcg.gov/links_tools.html] 

· FIMT contains many features that are not necessary for map creation in this workflow. The features that will be used from the FIMT gdb are: FirePolygon, FirePoint, FireLine, & AssignmentBreaks
[bookmark: _Toc398618321][bookmark: _Toc410209860][bookmark: _Toc410710817][bookmark: _Toc410996256]AGOL Organizational Account 
· This is different from the free-Public Account that anyone can get (more details: Section 2.1)
[bookmark: _Toc398618324][bookmark: _Toc410209861][bookmark: _Toc410710818][bookmark: _Toc410996257]Templates[footnoteRef:2] folder (Appendix 9.1) [2:  https://drive.google.com/folderview?id=0B9_PM0mqid5sX3FwNzJLMTdObFk&usp=sharing] 

· Save in the [image: ]documents folder
*This workflow was developed with ArcMap 10.2. It should work with 10.1, but issues may be encountered in 10.1 and not 10.2. My only suggestion is to upgrade or improvise.

[bookmark: _Toc410996258]QA/QC Process
[bookmark: _Toc410193912][bookmark: _Toc410209863][bookmark: _Toc410710820][bookmark: _Toc410996259]Work with your Situation Leader (SITL) to develop the process of how data is approved and integrated into the FIMT gdb as it is Collected.
[bookmark: _Toc410193913][bookmark: _Toc410209864][bookmark: _Toc410710821][bookmark: _Toc410996260]Integrate GSTOP standards into this process. GSTOP page 57 - Communications

[bookmark: _Ref410210617][bookmark: _Toc410996261][bookmark: _Ref397604564]AGOL :: Getting started 
This section will show the steps that will be necessary to create a map in ArcGIS Online (AGOL). These maps will be able to be shared and used with Collector in connected and disconnected (Offline) environments.
*Overview Video of this Workflow[footnoteRef:3] [3:  https://drive.google.com/folderview?id=0B4FY6Y_ZXT8tOGxBcHFJQnRxX0U&usp=sharing] 

[bookmark: _Ref410995289][bookmark: _Toc410996262] Get an AGOL Account:
· This account is different from the free Public Account you may have used before.
· How can the user request an account? Coming soon.
· Video: Join an organization[footnoteRef:4] (start at 59secs) [4:  http://video.arcgis.com/watch/1338/joining-an-organization] 

· Some of the steps mentioned may not be necessary. This will give you the general idea.
[bookmark: _Toc410996263]Sign In to an Organizational account: Sign-In[footnoteRef:5] [5:  http://www.arcgis.com/home/signin.html] 

· Video: Join an organization[footnoteRef:6] (start at 59secs) [6:  http://video.arcgis.com/watch/1338/joining-an-organization] 

· Some of the steps mentioned may not be necessary. This will give you the general idea.
[bookmark: _Toc410996264]Feature Service
“The feature service authoring process involves setting up a map document to define the data and symbology that will be exposed by the service” (ESRI Resources). Once this map document (mxd) is published as a feature service it can be utilized to create AGOL maps. Think of the service as the layers in ArcMap, you are bringing these symbolized layers from ArcMap into AGOL.
[bookmark: _Toc398618635][bookmark: _Toc410209868][bookmark: _Toc410996265]Publish a feature service from ArcMap
· Videos:
· Video[footnoteRef:7]: (start at minute 5:30) OR [7:  http://www.youtube.com/watch?v=uhE3Jx9MKwQ] 

· Publishing a Feature Service[footnoteRef:8]: (start at minute 6:24 through ~minute 12) [8:  http://www.youtube.com/watch?v=K19U_HFdooc] 

[bookmark: _Toc410209869][bookmark: _Toc410996266]Publish a feature service with a Service Definition file (.sd)
· Another method on how a feature service can be created
· A service definition can be uploaded to AGOL to create a new feature service
[bookmark: _Ref398022664][bookmark: _Toc398618636][bookmark: _Toc410209870][bookmark: _Toc410996267]Modify Feature Service Settings
· Section 6.3 for details
· Enabling a map to go offline: Take maps offline[footnoteRef:9] [9:  http://doc.arcgis.com/en/collector/ios/create-maps/offline-map-prep.htm#ESRI_SECTION1_BB7CFF5BFBC847DEA31610A38A510679] 

[bookmark: _Toc410996268]Creating AGOL Maps
You will create a new map (My Content > [image: Web Map] Create Map). Add the feature service you published to this new map ([image: Add Layer]Add > Search for Layers [In: My Organization]). Next you will modify the item details, pop-ups, & sharing. (Section 6.4)
· Video: Create a Map[footnoteRef:10] [10:  http://video.arcgis.com/watch/253/create-a-map] 

· Tutorial: Create and Share a Collector Map[footnoteRef:11] [11:  http://doc.arcgis.com/en/collector/ios/create-maps/create-and-share-a-collector-map.htm] 

[bookmark: _Toc410996269]Sharing / Groups
Maps can be shared as a map in Collector and as a Web Mapping Application. You can share maps with groups, your organization, or the public. Share the map with a group. Then make sure all the Collector users that you want using this map have been invited to the same group. If necessary create a group.
[bookmark: _Toc398618332][bookmark: _Toc398618639][bookmark: _Toc410209873][bookmark: _Toc410710830][bookmark: _Toc410996270]Videos
· Groups: Invite Others to Join Your Group[footnoteRef:12] [12:  http://video.arcgis.com/watch/251/invite-others-to-join-your-group] 

· Sharing: Share Maps & Aps with your Org[footnoteRef:13] [13:  http://video.arcgis.com/watch/1341/share-maps-and-apps-with-your-organization] 

[bookmark: _Toc398618333][bookmark: _Toc398618640][bookmark: _Toc410209874][bookmark: _Toc410710831][bookmark: _Toc410996271]Tutorials
· Groups: What is a Group[footnoteRef:14] [14:  http://doc.arcgis.com/en/arcgis-online/share-maps/groups.htm] 

· Sharing: Share Maps[footnoteRef:15] [15:  http://doc.arcgis.com/en/arcgis-online/share-maps/share-maps.htm] 

[bookmark: _Toc410996272]Embed a map into a website[footnoteRef:16] [16:  http://video.arcgis.com/watch/249/embed-a-map-in-your-website] 

· This is how you copy the map applications html code for sharing
[bookmark: _Toc410996273]Create Map Apps[footnoteRef:17] [17:  http://doc.arcgis.com/en/arcgis-online/create-maps/create-map-apps.htm] 

[bookmark: _Toc410996274]Syncing
When edits are made in an Offline map, syncing will need to occur to share those changes and receive updates. These synced edits will be viewable in your AGOL map.
· Section 6.6 for more details
· Tutorial: Go Offline[footnoteRef:18] [18:  http://doc.arcgis.com/en/collector/android/collect-data/offline-use.htm] 

· This is a good read[footnoteRef:19] to show different ways of getting feature services back to ArcMap. [19:  https://esriaustraliatechblog.wordpress.com/2014/05/30/bringing-your-data-from-the-cloud-back-to-earth-how-to-extract-your-data-from-arcgis-online/?blogsub=confirming#subscribe-blog] 

[bookmark: _Toc398618644][bookmark: _Toc410996275]Additional Resources
· Videos[footnoteRef:20] [20:  http://doc.arcgis.com/en/arcgis-online/reference/videos.htm] 

· Tutorials[footnoteRef:21] (Explore: Use, Create, & Share sections) [21:  http://doc.arcgis.com/en/arcgis-online/] 

[bookmark: _Ref398545753][bookmark: _Toc410996276]Collector :: Getting started 
In this section you will learn how to use the maps you create in AGOL with the Collector App. The interface differs slightly between [image: ]iOS and [image: ]Android.
*Quick Reference[footnoteRef:22]  *Overview Video of this Workflow[footnoteRef:23] [22:  http://doc.arcgis.com/en/collector/ios/collect-data/quick-reference.htm]  [23:  https://drive.google.com/folderview?id=0B4FY6Y_ZXT8tOGxBcHFJQnRxX0U&usp=sharing] 

Install the Collector Application
· Go to an App store[footnoteRef:24] on your device and search Collector for ArcGIS. Install. [24:  https://itunes.apple.com/us/app/collector-for-arcgis/id589674237] 

[bookmark: _Toc410996277]Logging into Collector
· Open Collector. Enter your username & password. (You must have an AGOL Organizational Log In to use Collector, see section 2.1)
[bookmark: _Toc410996278]Using the Maps
A. The GISS must first share the map with a Group in AGOL. Only the members of the Group can view the map in Collector. If necessary, create a new group.
B. Viewing maps: Once logged in, you will be able to browse for a map. Tap the map to open.
C. Downloading maps for Offline use: Maps that have had their settings configured correctly will have the option to download for Offline use. In All Maps tap: Download (Android) or  [image: Action] (iOS), for the map you choose.
· Pick a Basemap and the level of map detail. Video[footnoteRef:25] (start at 25:09) [25:  http://training.esri.com/Courses/ts_OfflineDataColl/player.cfm] 

· You will need to select: 
· the Work Area: the box identifying your bounding N/S/E/W extent
· and Choose Map Detail: the largest scale you can view (e.g. 1:18,000 is the largest scale for a Topo map and Ortho is good to about 1:4,000)
D. Collecting data and editing:
· You can add a new feature by using the [image: Collect New]Collect New tool. By default the feature is placed at your current location. Tap the [image: Map] map symbol to view and move the new feature to a different location in the map. Fill out the Collect Attributes [image: Collect Attributes]  table, then tap Done [image: Done](Android) or Submit (iOS).
· Video[footnoteRef:26]  [26:  http://video.arcgis.com/watch/2194/collector-for-arcgis-damage-assessment-survey] 

· Tutorial[footnoteRef:27] [27:  http://doc.arcgis.com/en/collector/ios/collect-data/collect-tutorial.htm] 

· Lines can be collected while moving using the Streaming option. Tap ‘Collect a new feature’. Select a line type to add, go to your map, tap STREAM. Collection parameters can be adjusted with the Collect settings [image: ]icon. When collection is complete tap Done  [image: Done] or Submit.
E. Syncing
· When connectivity is established go to the All Maps page and tap the Sync button to send your edits and receive any updates. You will see the number of changes next to Sync(6) (in Android) and [image: ] (in iOS) this represents the number of edits/changes you performed.
[bookmark: _Toc398618342][bookmark: _Toc398618649][bookmark: _Toc410996279]Additional Resources
· Overview of using Collector with iOS: video[footnoteRef:28] [28:  https://www.youtube.com/watch?v=5nmkHKNs0Ek] 

Tutorials[footnoteRef:29] (Explore: Create Maps & Collect Data) [29:  http://doc.arcgis.com/en/collector/ios/create-maps/create-maps.htm] 


[bookmark: _Toc398617520][bookmark: _Toc398618177][bookmark: _Toc398618322][bookmark: _Toc398618485][bookmark: _Toc398618629][bookmark: _Toc398617521][bookmark: _Toc398618178][bookmark: _Toc398618323][bookmark: _Toc398618486][bookmark: _Toc398618630][bookmark: _Toc410996280]Templates
This workflow utilizes an incident’s master FIMT geodatabase, an OTHER geodatabase, ArcGIS Online, and Collector. The GISS will keep the hosted feature service in AGOL synchronized with the layers in the master FIMT and Other geodatabases.
· You will start this workflow by downloading[footnoteRef:30] a copy of the templates folder (you should have these already since you are reading this document). Need a universal location to store data that anyone can access. The folder contains:  [30:  https://drive.google.com/folderview?id=0B9_PM0mqid5sX3FwNzJLMTdObFk&usp=sharing] 

[image: ]2014_GSTOP_Folder_Template – File directory structure required by GSTOP
[image: ] LayerFiles – Unique symbology used in AGOL
 Tools – Automation tools used throughout the workflow (See Appendix 10.5 for details)
 Tutorials – Additional ESRI materials for familiarizing yourself with AGOL & Collector 
[image: ] YYYY_IncidentName_IncidentNumber_OTHER_Arc10.gdb – Template file geodatabase that can be copied and store non-FIMT fire related data
 AGOL_PUBLICservice_YYYY_IncidentName_IncidentNumber.mxd – Template mxd that can be used to create a Public feature service
 AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.mxd – Template mxd that can be used to create an IMT service
[image: ]AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.sd - File that can be added to your AGOL account to create a feature service
 Workflow-v2.pdf – This document
[image: ] Workflow – FlowChart.pdf (needs to be created) – Flow chart of steps involved in this workflow

Save the templates folder to the incident documents folder. 
The mxds and gdb are setup in WGS84. Feel free to change the projection to your local one.


[bookmark: _Toc410996281]Workflow Overview
These are the main steps that you will be completing.
Steps completed in ArcMap are highlighted throughout the workflow so it’s clear when you are working in ArcMap or AGOL

[bookmark: _Toc410996282]GISS Workflow Overview:
1. Before leaving for a fire you can complete steps 2-7 (this will allow Operations folks to start collecting fire data immediately)
2. Log In to AGOL
3. Create feature service by uploading the service definition (AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.sd)
4. Update the feature service item details with specific fire information
5. Make IncidentName_Operations map for folks heading to the fire
6. Add whatever spatial data you may have (fire location from Resource Order)
7. Save & Share
8. Check Groups to make sure everyone is added that needs access
9. Arrive to the fire/ICP
10. Create FIMT geodatabase
11. Add a copy of the Other geodatabase in the incident_data folder
12. Run TOOL01
13. Keep the master gdbs (FIMT & Other) in sync with the feature service
14. Create other AGOL maps as time allows


[bookmark: _Ref410813154][bookmark: _Toc410996283]Maps built in AGOL
These are the maps that you can create in ArcGIS Online. As time allows, you can start by creating maps in Phase I and continue to Phase III.
Phase I: Two distinct Operations Groups
· [image: Web Map] Operations (Line Operations – group that can edit/add features in Collector)
· [image: Web Map] CampOperations (Viewers only, won’t have edit rights)
Phase II:
· [image: Web Map] Support (Medical, Communications and Ground Support)
Phase III:
· [image: Web Map] Public

[bookmark: _Ref397606348][bookmark: _Ref397606395][bookmark: _Ref397606402][bookmark: _Ref397606439][bookmark: _Toc410996284]Workflow
0. [bookmark: _Ref398199027][bookmark: _Toc410996285]Getting Setup
[bookmark: _Toc410996286][bookmark: _Toc410710847]You will need to have the file directory structure set up now. A template is provided:                                 [image: ]2014_GSTOP_Folder_Template
[bookmark: _Toc410996287]Save [image: ]CollectorPilot_Workflow_Templates into the documents folder. (Figure 1)
[bookmark: _Ref410813214][bookmark: _Toc410996288]If you have not already created the master FIMT gdb for your incident, create one now.
[bookmark: _Ref410813295][bookmark: _Toc410996289][bookmark: _Toc410710848]Run the called TOOL01. Find this in the Tools folder that you downloaded:
([image: ]WorkFlow_Tools.tbx > TOOL01). It will do a few minor modifications to the FIMT gdb schema. 
[bookmark: _Toc410996290]Edit/add fire data to the FIMT gdb
[bookmark: _Toc410710849][bookmark: _Toc410996291]Make a copy of the Other gdb template:[image: ] YYYY_IncidentName_IncidentNumber_OTHER_Arc10.gdb Rename and save in your incident_data folder.
[bookmark: _Toc410710850][bookmark: _Toc410996292]Make copies of the following (& rename), save in the incident_data folder:
· [image: ]AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.sd
B. Make a copy, save in the projects folder, and rename:
· [image: ] AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.mxd
· [image: ] AGOL_PUBLICservice_YYYY_IncidentName_IncidentNumber.mxd
	[image: ]
[bookmark: _Ref410995157]Figure 1
	






< Incident Directory Catalog File Names (example)




[bookmark: _Ref410201968]
0. [bookmark: _Ref410813242][bookmark: _Toc410996293]Create the Feature Service
There are two ways to create a feature service. I recommend creating your feature service with the service definition file (6.2.1). The other option is to use ArcMap to create the feature service (6.2.2). If you want to add additional layers to AGOL, you can publish them this way. You should know how to do both options.
[bookmark: _Toc410710852][bookmark: _Ref410993245][bookmark: _Toc410996294]Option #1: USE A SERVICE DEFINITION FILE TO CREATE A NEW FEATURE SERVICE
A. [bookmark: _Toc410209950]In a web browser, Log In to your AGOL account.
B. [bookmark: _Toc410209951]Go to MY CONTENT > [image: ]> From my computer > Browse to the (.sd) file:   [image: ]AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.sd
C. While the .sd file is uploading a feature service is automatically created from it.
D. Next, update the feature service information – Go into its item details and update the Title, Summary, Description, Tags….
E. Once the feature service is created you will populate it with data to it via ArcMap. 
F. In ArcMap, Sign In to your ArcGIS Online Account [image: ]
G. Add the layers from the incident OTHER and FIMT gdbs to the map
H. Open the [image: ]Catalog window > My Hosted Services > Drag and drop your feature service into ArcMap
  [image: ]1-Drag & Drop
2-Service appears in the TOC

Figure 2
I. In the Table of Contents (TOC), right click the group header of your feature service > Edit Features > Create Local Copy for Editing (Figure 3)
J. Right click the group header again: Edit Features > Start Editing. Copy & Paste the new features from the FIMT gdb to the feature service
· Use the last_edited_date field to help you identify the changes that need to be added
· If you want to query with ‘Select by Attribute’ this is the format you would use: "last_edited_date" > date '2015-02-06 16:26:11'

	[image: ]
[bookmark: _Ref410893572][bookmark: _Ref410893524]Figure 3: First you will Create a local copy for editing. Then make all of your edits.
	[image: ]
[bookmark: _Ref410893620]Figure 4: Once all the edits have been completed, you will Synchronize Local Edits with Server


K. Save and Stop Editing
L. Synchronize Local Edits with Server (Figure 4)
M. Once you are done editing, continue on at section 6.3.1
[bookmark: _Toc410710853][bookmark: _Ref410993266][bookmark: _Toc410996295]Option #2: PUBLISH A NEW FEATURE SERVICE FROM ARCMAP
A. Open [image: ]AGOL_IMTservice_YYYY_IncidentName_IncidentNumber.mxd
B. [bookmark: _Toc398618656]Repoint layers to your master FIMT & OTHER geodatabases
C. Fill out/modify the Map Document Properties (Figure 5 & Figure 6)
	
	[image: ]
[bookmark: _Ref397673275]Figure 5: Access Map Document Properties
	[image: ]
[bookmark: _Ref397673283]Figure 6: Fill in Map Document Properties Form




	[bookmark: _Toc410710854][bookmark: _Toc410996296][bookmark: _Toc398618658]Publish a new service through ArcMap:
[bookmark: _Toc410209890][bookmark: _Toc410710855][bookmark: _Toc410996297]In ArcMap, Sign In to your ArcGIS Online account


Figure 7: “Sign In” to your AGOL Account. Enter your Username & Password when prompted.
[image: ] For Sign In issues see Appendix 8.1.5

	[image: ]


· [bookmark: _Toc398618659][bookmark: _Toc410209891][bookmark: _Toc410710856]Publish your feature service: Figure 8 thru Figure 15 (Your mxd needs to be in Data View not Layout View)
	[image: ]
[bookmark: _Ref397608425]Figure 8: In the mxd you just set up: 
File > Share As > Service…
	[image: ]
Figure 9: For a new feature service, choose “Publish a service”. Click Next.

	[image: ]
Figure 10: Name the service (default is the name of the mxd). Click Continue.
	[image: ]
Figure 11: Select Feature Access and UNCHECK Tiled Mapping

	[image: ]
[bookmark: _Ref410985864]Figure 12: Under Feature Access  check:
Create, Update, Delete, Query, and Sync (Appendix 10.4 for details about Operations Allowed)
	

	

	[image: ]
Figure 13: Enter Summary, Tags, & Description. Information already included comes from Map Document Properties (Figure 5).
	[image: ]
Figure 14: Sharing with groups can be now or later in AGOL.

	[image: ]
[bookmark: _Ref397608443]Figure 15: Analyze & Publish the feature service. It is ok to ignore [image: ] warnings. [image: ]  warnings need to be addressed.

	


[bookmark: _Ref397944289][bookmark: _Toc410996298]


Feature Service in AGOL
View and modify settings for the new feature service in ArcGIS Online.

[bookmark: _Toc410209893][bookmark: _Ref410646646][bookmark: _Toc410710858][bookmark: _Toc410996299]Sign In to your AGOL Organizational Account: Sign-In[footnoteRef:31] (More information: Section 2.1) [31:  http://www.arcgis.com/home/signin.html] 

	 
[image: ]
Figure 16
	
Feature services you create initially appear under the My Content section of your AGOL account.
Create a new folder (YYYY_IncidentName) and move the new IMT service there.
If you create a Public service, don’t move it. It needs to stay where it is so it can be overwritten.



[bookmark: _Ref397937801]
[bookmark: _Toc410209894][bookmark: _Toc410710859][bookmark: _Toc410996300]Tour of a feature service – what you need to know:
	
[image: ]
[bookmark: _Ref410985006]Figure 17: Access the feature service item details via the arrow, ‘View Item Details’.
	[image: ]
Figure 18: Share with the appropriate Groups.



		[image: ]
	
Edit the Service



[image: ]
Figure 19: You can edit the Title, Summary, and Description.
	
[image: ]
Figure 20: This is where you can enable or disable ‘Editing’ & ‘Sync’. There must be one layer in a map with Sync enabled in order for it to go Offline in Collector. 


 [image: ]
[bookmark: _Ref398540510]Figure 21: This is how you enable or disable attachments in AGOL.
[bookmark: _Toc398618677]
In AGOL modify your feature service Item Details:
[bookmark: _Toc410209895][bookmark: _Toc410710860][bookmark: _Toc410996301][bookmark: _Toc398618678]My Content  >  [image: Map Service]IncidentName_service
	[bookmark: _Ref398622372][bookmark: _Toc410209896][bookmark: _Toc410710861][bookmark: _Toc410996302]Modify Item Details for the feature service: 
· Access the Item Details (Figure 17) > Enable Editing & Sync.
· Share with the appropriate group(s). Create a group if necessary.
· Track Edits should already be enabled
[image: ]NOTE: An AGOL map must have at least one layer sync-enabled to be used Offline in Collector.

	[image: ]
[bookmark: _Ref398540520]Figure 22:  Enable Editing & Sync



[bookmark: _Ref398019151][bookmark: _Toc410996303]Setting up Maps in AGOL
[bookmark: _Toc410209898][bookmark: _Toc410710863][bookmark: _Toc410996304][bookmark: _Toc398618666]Once a feature service is created and configured you will be ready to create an AGOL map.

[bookmark: _Toc410996305][image: Web Map] IncidentName – Operations – The first AGOL map you will create.
[bookmark: _Toc410209900][bookmark: _Toc410710865][bookmark: _Toc410996306]This map is intended to be shared with an Operations group in which members can add data in Collector.
A. [bookmark: _Toc410209901][bookmark: _Toc410710866][bookmark: _Toc410996307]Go to My Content. Click  [image: Web Map] Create Map
B. [bookmark: _Toc410209902][bookmark: _Toc410710867][bookmark: _Toc410996308]Add: “[image: Map Service]AGOL_IMTservice_YYYY_IncidentName_IncidentNumber” to the map
· Remove any layers you do not wish to use
· Add one additional Basemap as a layer: [image: Add Layer]Add > Search for Layers [In: ArcGIS Online] > Find: USA Topo Maps (for export)
· [bookmark: _Toc398618687][bookmark: _Toc410209903][bookmark: _Toc410710868][bookmark: _Toc410996309][bookmark: _Toc398618686]Select: Imagery with Labels as the Basemap
B. [bookmark: _Toc410209904][bookmark: _Toc410710869][bookmark: _Toc410996310]Rename Layers (Drop the first part of the name), so they look nice in the table of contents
C. [bookmark: _Toc410209905][bookmark: _Toc410710870][bookmark: _Toc410996311][bookmark: _Toc398618688]Reference the table below and incorporate suggestions
D. [bookmark: _Toc410209906][bookmark: _Toc410710871][bookmark: _Toc410996312]Add  [image: Bookmarks] bookmarks so users can easily navigate to different extents of the fire (e.g., different Divisions or areas of interest)
E. [image: Save] Save As and Name your map (IncidentName_Operations)


	
	
[image: ]Note: Any unnecessary layers can be removed from an AGOL map once the feature service is added.

	





· Ordering & Settings for [image: Contents] Contents (TOC) in AGOL:
	Layers (Note some are checked off by default)
	Disable Editing
	
Transparency
	
Source & Other Options

	FirePoint
	
	
	IMT Service, Create Labels

	PhotoPoints_MapNotes
	
	
	IMT Service

	OtherPoints
	
	
	IMT Service

	AssignmentBreak
	
	
	IMT Service

	FireLine
	
	
	IMT Service

	Labels
	X
	
	IMT Service , Hide in Legend, Remove Pop-Up

	Structures
	
	
	IMT Service

	IR Isolated Heat
	X
	
	IMT Service

	IR IntenseHeat
	X
	
	IMT Service

	IR ScatteredHeat
	X
	25%
	IMT Service

	IR HeatPerimeter
	X
	
	IMT Service

	TFR
	X
	
	IMT Service, Remove Pop-Up

	FirePolygon
	X
	50%
	IMT Service, Remove Pop-Up

	OtherPolygon
	X
	
	IMT Service

	RehabPoints
	
	
	IMT Service, Create Labels

	Rehab Lines
	
	
	IMT Service

	Retardant Avoidance
	X
	
	AGOL Layer

	USA Topo Maps (for Export)
	
	
	AGOL Layer

	Imagery w Labels
	
	
	Basemap


**Maps cannot go offline with the [image: Map Service] US Forest Service Aerial Fire Retardant Avoidance Areas layer in it. Add the layer into you feature service. Be careful with adding a Directions layer too, when in a map it may disable it from going Offline. Provide feedback of your experience.


F. Share map with Operations group (or other appropriate group(s))
[image: ]
Figure 23: Click the 'Share' button and select the groups to share with.
G. Check the settings of the map and make sure it is set for Offline use
[image: ]
[bookmark: _Ref398541296]Figure 24
G. Optional: Add  [image: Get Directions] Directions
H. Optional: Add: [image: Map Service] US Forest Service Aerial Fire Retardant Avoidance Areas 
 note: this layer disables maps from going Offline
I. Optional: Set a refresh interval for any of the layers in the map.
[image: ]
[bookmark: _Toc410996313][bookmark: _Toc398618729][image: Web Map] IncidentName_CampOperations
[bookmark: _Toc410209908][bookmark: _Toc410710873][bookmark: _Toc410996314]This map is for ‘Camp Operations’ group, viewers of all of the IMT data. These are other individuals that are part of the IMT that will have viewing rights, but no editing rights, and are able to view the map in Collector and go Offline.
A. Make a copy of the Operations map. Save As: IncidentName_CampOperations
B. Disable editing on all of the layers but the PhotoPoints_MapNotes
C. Share with the Viewer Group
D. Make a web map app (Section 2.5.4). Some folks will want to view the map on their computers. Share with ‘Operations & Support Group’ too?



[bookmark: _Toc410996315][bookmark: _Toc398618730][image: Web Map] IncidentName_Support
[bookmark: _Toc410209910][bookmark: _Toc410710875][bookmark: _Toc410996316]This group’s primary use of the map is to assist in navigating around an incident. A transportation map.
A. Make a copy of the Operations map. Save As: IncidentName_Support
B. Use the table below to make adjustments to the map layers
C. Share with the Support Group
Ordering & Settings for [image: Contents] Contents (TOC) in AGOL:
	Layers (Note: some are checked off by default)
	Disable Editing
	
Transparency
	
Source

	FirePoint
	X
	
	IMT Service,  Create Labels

	OtherPoints
	X
	
	IMT Service

	AssignmentBreak
	X
	
	IMT Service

	FireLine
	X
	
	IMT Service

	Labels
	X
	
	IMT Service , Hide in Legend, Remove Pop-Up

	PhotoPoints_MapNotes
	
	
	IMT Service

	Structures
	X
	
	IMT Service

	TFR
	X
	
	IMT Service, Remove Pop-Up

	FirePolygon
	X
	50%
	IMT Service, Remove Pop-Up

	OtherPolygon
	X
	
	IMT Service

	 World Street Map (for Export)
	
	
	AGOL Layer

	USA Topo Maps (for Export)
	
	
	AGOL Layer

	Imagery w Labels
	
	
	Basemap


[bookmark: _Toc398618728]
[bookmark: _Toc410996317][image: Web Map] IncidentName Fire – Public Map - (Give an intuitive name) Viewing map for the public.
A. Open the map template provided: 
[image: ] AGOL_PUBLICservice_YYYY_IncidentName_IncidentNumber.mxd
B. Repoint the layers to your gdbs
C. Publish the feature service
· For the Feature Access option (Figure 12) only check: Query
D. Once the service is published go to your AGOL account and create a new map
E. In AGOL Add: [image: Map Service] AGOL_PUBLICservice_YYYY_IncidentName_IncidentNumber
F. Disable pop-ups for all layers except FirePolygon (this pop-up could show the fire name & date). Re-enable pop-ups you see useful or create labels. 
G. Choose a Basemap (Topographic or Streets)
H. Optional: Imagery / Topo (add as layer)
I. Sharing: Everyone (Public)
J. Create a web mapping App & share URL (Section 2.5.3 & 2.5.4)
Ordering & Settings for [image: Contents] Contents (TOC) in AGOL:
	Layers 
	Transparency
	Source

	Controlled Fire Line
	
	IMT Service

	Uncontrolled Fire Edge
	
	IMT Service

	Closure Points
	
	IMT Service

	OtherPolygon
	25-50%
	IMT Service

	FirePolygon
	50%
	IMT Service

	Streets
	
	Basemap


K. Updating the public feature service: 
· Use the same mxd you used to create the public feature service
· As the master FIMT & Other gdbs are updated, republishing the public feature service will be necessary
· Open the public mxd > File > Share As > Service….
· The ‘Share as Service’ window will come up. Choose the third option ‘Overwrite an existing service’ (Figure 25)
· Select the existing service to overwrite (Figure 26)
	[image: ]
[bookmark: _Ref410994200]Figure 25
	[image: ]
[bookmark: _Ref410994220]Figure 26


· The feature service in your public map should now be updated
· Repeat this process as often as necessary


[bookmark: _Toc410996318]Sharing Maps for use in Collector
Refer to Section 3 for more details.
· AGOL map is shared with a Group. Collector users must be invited to the same Group to be able to view the map.
· With Editor Tracking enabled through ArcCatalog, editor names and dates are automatically recorded.
· Plan on giving a 5 minute tutorial to new Collector users.
· Have Collectors use their maps in Offline mode so that they will have labels.


[bookmark: _Ref397949561][bookmark: _Toc410996319]Syncing Data: Updating the FIMT gdb
How to sync your incident FIMT gdb with the AGOL changes.
A tool is being created that will automate some of the steps here in sections 6.8 & 6.9.
Open (create) an mxd setup for editing:
	[image: ]Add the master FIMT gdb and Other gdb.
Then drag and drop your feature service here.





Figure 27: IncidentName_edits_wAGOL.mxd
	




[bookmark: _Toc398618696][bookmark: _Toc410209915][bookmark: _Toc410710880][bookmark: _Toc410996321][bookmark: _Toc398618697][bookmark: _Toc398618698]The following steps show how to add the new data/changes to the FIMT gdb (Figure 28-Figure 33).
	[image: ]Your Feature Service

[bookmark: _Ref410994387][bookmark: _Ref410994396]      Figure 28: Add your feature service to ArcMap. Do this by dragging and dropping from the ArcCatalog window > My Hosted Services, into ArcMap.
	[image: ]
       Figure 29: Edit the Incident through the FIMT toolbar.
	[image: ]
        Figure 30: Open the table for the FirePoints feature service. Sort by last_edited_date to see what is new. Select new records. If there are multiple layers with the same names are confusing, give one set a unique name.

	[image: ]
       Figure 31: With the editor arrow you will right click the highlighted items in the Data View.
[image: ]
Figure 32: Copy & Paste.
Select FirePoint as your target. [OK]
	[image: ]
       Figure 33: AssignmentBreaks: Add new Breaks manually.

1.Select one new AssignmentBreak at a time &  zoom to it. 
2.Use the Floating AssignmentBreak FIMT tool to add the new Break.
	

The sequence used to add the new FirePoints (Figure 26-28) will be used to add new FireLine.




· When you copy-paste using the FIMT button [image: ], the PTType attribute comes across as UNKNOWN, and you have to manually change each field or will have to add each point manually using the FIMT ‘Copy to FirePoints’ button. Using the steps above (Figure 27-32) allow you to bulk copy-paste.




[bookmark: _Ref397949625][bookmark: _Toc410996322]Syncing data: Updating the feature service
In the last section edits that were made in AGOL/Collector were brought into ArcMap and added to the FIMT gdb. This section shows how to add the changes that were made in ArcMap – in the master FIMT & Other gdbs  to the feature service.
	[bookmark: _Toc410996323][bookmark: _Toc410209916][bookmark: _Toc398618699]Before you edit the feature service as a local copy create a backup. The steps follow (A & B). 
	[image: ]
[bookmark: _Ref410987105]Figure 34



A. [bookmark: _Toc410996324][bookmark: _Toc410209917][bookmark: _Toc410710882]Right click the group header of your feature service > Edit Features > Create Local Copy for Editing 
B. [bookmark: _Toc410209918][bookmark: _Toc410710883]Navigate to your ArcGIS folder: 
C:\Users\<Current User>\Documents\ArcGIS\FeatureServiceLocalEdits  (If you can’t find it, click the [image: ]’Default Geodatabase Icon’ on the Catalog window in ArcMap) You will see a folder: [image: ] FeatureServiceLocalEdits. This is where you can get a copy the feature service gdb. (Figure 34)
	[image: ]
[bookmark: _Ref410911571]Figure 35: Archiving a copy of the feature service:
Export service to a dated backup folder.
	




C. [bookmark: _Toc410209920][bookmark: _Toc410710885][bookmark: _Toc398618701]Save the copy to the backups folder (Figure 33). Rename with a date and time stamp.
[bookmark: _Toc410996325]One last thing to do before you start updating the feature service, is to populate all of the Latitude/Longitude fields in both gdbs (FirePoint, AssignmentBreak, Structures, OtherPoints, RehabPoints) TOOL is under construction to complete this.
[bookmark: _Toc410996326]Now, right click a layer in your feature service > Edit Features > Start Editing
A. [bookmark: _Toc410209921][bookmark: _Toc410710886]Use the last_edited_date field to find the most recent edits
B. [bookmark: _Toc398618702]Copy & Paste the new features from the FIMT gdb to the feature service
C. Copy & Paste the new features from the Other gdb to the feature service (except the FireLine, FirePoint, AssignmentBreak, & FirePolygon)
	[image: ]
Figure 36: First you will Create a local copy for editing. Then make all of your edits.
	[image: ]
[bookmark: _Ref397943734]Figure 37: Once all the edits have been completed, you will Synchronize Local Edits with Server


[bookmark: _Toc398618703][bookmark: _Toc410996327][bookmark: _Toc410209922][bookmark: _Toc398618704]Once all of the syncing is complete Save & Stop Editing
[bookmark: _Toc410996328]Synchronize Local Edits with Server (Figure 37)
[bookmark: _Toc398618705][bookmark: _Toc410209923][bookmark: _Toc410710888][bookmark: _Toc410996329]Repeat these steps as often as necessary


[bookmark: _Toc410996330]Tile Packages (tpks)
[bookmark: _Toc410209925][bookmark: _Toc410710890][bookmark: _Toc410996331]Create tpks using Collector or ArcMap in advance. Side load these on to a Collector user’s device. 
[bookmark: _Toc398618735][bookmark: _Toc410996332]Create a tpk using Collector
· Make a map in AGOL. Open it in Collector and download for Offline use. During the download process: 
· Download a new basemap
· Choose your work area: Eye-ball a ~50x50mi area around the fire (or your best judgment according to the direction the fire is burning).
· Choose map detail (topos go to about 1:18,000 & ortho to about 1:4,000)
· Once the map is done downloading you will need to connect the device to your computer to retrieve the basemap:
· For iOS use the iTunes Store
· For Android, load them to the Collector folder, like your device is an external drive.
· Rename the tpks
· Load the basemaps to other devices with the same procedure as when you were retrieving them.
· [image: Note]Note: Tile packages are supported from ArcGIS 10.1 for Desktop onwards. Tile package will fail to open with older ArcGIS for Desktop versions (10 or older).
· More details: Using Your own Basemaps layers with Collector[footnoteRef:32] [32:  http://blogs.esri.com/esri/arcgis/2014/03/23/using-your-own-basemap-layers-with-collector-for-arcgis/] 

[bookmark: _Toc410996333]Create a tpk through ArcMap.
The only map service you can create a TPK with through ArcMap is OpenStreet. You will need your own DRG or Ortho rasters.
· Add the raster of your choice to ArcMap
· In ArcMap enable: Customize > ArcMap Options > Sharing Tab >  Enable ArcGIS Runtime Tools.
· Add your imagery or layers to ArcMap
· File > Share As > Tile Package… (Figure 38)
· Tile Package: where to Save; Tile Format: Tiling Scheme, Tile Format, Level of Detail; and Item Description: Summary, Tags, Description (Figure 39)
	[image: ]
[bookmark: _Ref401127289]Figure 38
	[image: ]
[bookmark: _Ref401127374]Figure 39




[bookmark: _Toc410996334]Transition
[bookmark: _Toc410209929][bookmark: _Toc410710894][bookmark: _Toc410996335]A plan needs to be made with how AGOL will be transitioned between teams.
When the transition happens (even if the new team is using AGOL) copies should be made of the hosted feature services and they should be placed in the incident data folder. The new GISS should be added to the correct groups for the fire even if they don’t currently plan to use AGOL. This gives them the flexibility to work with it in the future. Changes in services between teams happens all of the time in fire (especially the PIO shop) so this won’t be out of the ordinary. 


[bookmark: _Toc410996336]Additional Information:
[bookmark: _Toc398616688][bookmark: _Toc398617632][bookmark: _Toc398618289][bookmark: _Toc398618432][bookmark: _Toc398618596][bookmark: _Toc398618739][bookmark: _Toc398616689][bookmark: _Toc398617633][bookmark: _Toc398618290][bookmark: _Toc398618433][bookmark: _Toc398618597][bookmark: _Toc398618740][bookmark: _Toc410996337]Request Assistance:
· http://www.esri.com/services/disaster-response
[bookmark: _Toc410996338]Best Practices :: GPS & Preserving Battery Life
· It is recommend that people turn off location settings for everything except Collector and the camera and that they review fetch/push settings for things like mail, dim the brightness, and turn off notifications.  
· Reference these links:
· http://www.pcmag.com/article2/0,2817,2367542,00.asp
· http://ipod.about.com/od/iphone3g/tp/iphone-battery-life.htm
· http://www.zdnet.com/pictures/31-ways-to-improve-your-iphones-battery-life/
· http://www.cnet.com/how-to/how-to-get-better-battery-life-on-android/
[bookmark: _Toc410996339]Attachments Workflow:
· Attachments will only be enabled on PhotoPoints_MapNotes. (a GlobalID field is included in this feature)
· How do I download attachments out of AGOL? [ArcGIS for Desktop 10.2 will support "Creating a local copy" of the service that will also contain the attachments. (ESRI Help)]
· Python script available to download multiple attachments.
[bookmark: _Toc410996340]Things to be aware of:
· If you have downloaded a map on your mobile device and you need to update it with the AGOL copy, go to your main My Maps page in Collector and re-sync to get updates.
· If you are out of service and are forced to re-sign back in, you may not be able to.
[bookmark: _Ref410899885][bookmark: _Toc410996341]Problem Shooting:
· [bookmark: _Toc398618745]Sign out of Collector App and sign back in.
· [bookmark: _Toc398618746]Restart App &/or mobile device.
· Issues logging into AGOL:
· http://support.esri.com/en/knowledgebase/techarticles/detail/40178
· And Icon in task bar: http://gis.stackexchange.com/questions/108365/arcgis-online-and-sign-in-options-are-greyed-out-in-arcmap-10-2-2
[bookmark: _Toc410996342]Location Tracking:
· Create a Location Tracking feature using the ‘Create Layer’ option
· Add to a map and disable its Editing
· You can enable how often it tracks in the settings for the map.
[bookmark: _Toc410996343]My Favorites: 
· Save different services that you frequently use or that interest you. 
· Item Details – Add to Favorites[footnoteRef:33] [33:  http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm] 

· Consider adding: basemaps (for export), other layers, and templates so you can quickly add them to any map.
[image: ]
[bookmark: _Toc398616698][bookmark: _Toc398617642][bookmark: _Toc398618299][bookmark: _Toc398618442][bookmark: _Toc398618606][bookmark: _Toc398618749][bookmark: _Toc398616699][bookmark: _Toc398617643][bookmark: _Toc398618300][bookmark: _Toc398618443][bookmark: _Toc398618607][bookmark: _Toc398618750][bookmark: _Toc410996344]Route/Direction Layer:
If you are signed in with an organizational account, you can use the map viewer to get directions[footnoteRef:34] and add the route as a layer in your map. You must have privileges to create items in order to save the map with the route layer. You can configure the layer, create a route map, and perform analysis on the route. Your route map is like any other map you create with the map viewer—you can configure it, share it through a web app, story template, blog, and so on, and use it in a map client such as an iOS device, Android phone, and ArcGIS for Desktop. [34:  http://doc.arcgis.com/en/arcgis-online/use-maps/get-directions.htm] 

1. Open the map viewer and click Directions [image: Get Directions] to display the Directions panel to the left of the map.
2. Get directions[footnoteRef:35] by adding an origin and one or more destinations. [35:  http://doc.arcgis.com/en/arcgis-online/use-maps/get-directions.htm] 

3. Once you get your directions, click Add as Layer.
4. To add an additional route, create a new set of directions and add that layer to your map. Each route appears as a layer in the Contents of your map.
5. If you have privileges to create items, save your map.
The route layer is stored in the map; it is not an independent layer you can reuse in other maps. If you perform analysis on the route[footnoteRef:36], you create a hosted feature layer as a result of the analysis. This hosted feature layer is an independent layer you can reuse in other maps. [36:  http://doc.arcgis.com/en/arcgis-online/use-maps/perform-analysis.htm] 

[bookmark: _Toc410996345]Dashboard – discover more at: http://doc.arcgis.com/en/operations-dashboard/windows-desktop/author/create-a-map.htm
[bookmark: _Toc410996346]Explorer App – discover more at: http://doc.arcgis.com/en/explorer/


[bookmark: _Toc410996347]Glossary/Terminology:
· AGOL: ArcGIS Online
· FIMT: Fire Incident Mapping Tool, http://gis.nwcg.gov/links_tools.html
· GISS: Geographic Information Systems Specialist
· GSTOP: GIS Standard Operating Procedure, http://gis.nwcg.gov/gstop_sop.html
· IMT: Incident Management Team
· Hosted Feature Service: also referred to as ‘feature service’ or ‘service’
· Local Copy: feature service in ArcMap after you right click the header and create a Local Copy (Figure 2)
· Rest End Point
· Service Definition


[bookmark: _Toc410996348]Appendix
[bookmark: _Toc398616704][bookmark: _Toc398617648][bookmark: _Toc398618305][bookmark: _Toc398618448][bookmark: _Toc398618612][bookmark: _Toc398618755][bookmark: _Toc398618756][bookmark: _Ref398015072][bookmark: _Toc410996349][bookmark: _Toc398618757]A zipped folder contains the needed templates: 

[image: ]
Figure 40: Screen shot of templates folder that will be downloaded.
	
	


[bookmark: _Toc398618758][bookmark: _Toc410996350]Features in the ‘Other’ feature dataset:
	




[image: ]
	
[image: ]
	
This structures layer is for collecting structure information on an incident. Structure datasets acquired from other sources would be separate from this.
[image: ]



[bookmark: _Toc410996351]GSTOP Compliant File Structure
[image: ]Backup of feature service
Map documents used to create feature services
Template_Other.gdb
Where to save the templates folder you downloaded
TilePackages


[bookmark: _Ref410993686][bookmark: _Toc410996352]Figure 8 Notes
Choose what level of access connecting users should have to the features in the feature service. You can choose as many of the following options as apply:
· Query: Connecting users can view and select features from the feature classes in the feature service.
· Create: Connecting users who have the necessary database privileges can add features to feature classes in the feature service.
· Delete: Connecting users who have the necessary database privileges can delete features from feature classes in the feature service.
· Update: Connecting users who have the necessary database privileges can edit existing features in the feature classes in the feature service. (ESRI Resources)


[bookmark: _Ref411334691]Tools
Tools
[image: ]Attachments-arcgis-rest-toolbox-master
DownloadAttachments_fromAGOL.pyt
	[image: ]Pull Attachments: this tool can be run to batch download attachments from AGOL
Replicate Feature Service: this will download a copy of your feature service as gdb in a zipped folder
     [image: ]ExportAttachments_from_FGDB.tbx
	[image: ]ExportAttachments: this will pull the attachments out of a file geodatabase stored locally and put copies into a folder of your choice
WildfireGISS_Tools
     [image: ]WildfireGISS_Tools.tbx: view the document ‘WildlandFire Mapping Toolkit.pdf’ for more information
	[image: ]Batch – Change Source of GDB
	[image: ]Batch Acreage Change
	[image: ]Batch Change Source of GDB
	[image: ]Batch Date Change
	[image: ]Batch Export MXDs to PDF
	Wildland Fire Mapping Toolkit.pdf
    Workflow_Tools: tools specifically created to automate parts of this workflow
	[image: ]SubModel: a submodel that does not get ran. It is a component of TOOL01
	[image: ]TOOL01: this tool is ran to modify the FIMT gdb schema at the beginning part of the workflow
RehabLine.csv

[bookmark: _Toc410996353]Disclaimer
This is an example of a Sensitive Data Map Disclaimer. It may be duplicated for use or modified to meet the needs of the incident. 

PROTECTED INFORMATION - NOT FOR PUBLIC RELEASE 
This map contains information about historic and/or prehistoric cultural resources that may be withheld under section 304 of the National Historic Preservation Act of 1966, or under section 9 of the Archaeological Resources Protection Act of 1979. Do not copy or distribute this information. Abuse may result in fines and/or imprisonment.
Introduction  		 Page 4

image9.png




image69.png
Untitled - ArcMap

Fle Edt View Bookmaks Insert Selecton Geoprocessing Customize Windows Help

=181]

DBES BB x| o b [F AN EEE@ g s Ohp RN A2 MANEEI SO
W A EINNB Al FAERANQIE €% (K-0/ K@ 7@ M5 S TR seeng-[0]8 0 51 g
[ e LS QG IR P LB IBH T BT .
eson Bl
Ho ol simatiiiainn, [ mRoex ¢
| S raargmas D( H
et i e ot o
Frrype | Pontame [ Laber | Captuet
17 ot Set ot Set_[<tul>-
Tl5 florsor tset |k 3
36 ot [uotset fatup ) g
] &
S0 florsor — atset |t
Bl florsor—Wtset [t o
¥
J
. 5|
o 10 [E]S] Goutofsssected)
Fesbant | reront B -
 orawing~ K () 81| (] - A - < [[0) el o ElB 1 ulA->-2 PR R || el

sart| € [[@7 | w0l & 5]

933794371 452251173 Meters

Desktop 7 [2 1) [V atll B 1084 BN




image70.png
& Uni

Fle Edt View Bookmaks Insert Selecton Geoprocessing Customize Windows Help

DB ES& BB X |0 ol b- 25 S EEE® D $ g avse [ 2T 4 415 @ 8 B S 6 g
Editor~ |~ ] ™ f1- 3% Nl dh £ 2 BRANQIFE € -0/ @ 7@MD TR sepeng-[O]8 O 51 g
O ED DB G T RPAR|IEH 2200 (BT
"OBJECTID | PTType | Poi ¥
> I T
2l s
3 s
DT BN B o
S[io uote
S 7 [ s
| Copy the selected dement().
@ 1dentfy...
& zoomToSekctedFeatures
B |8 pantoseectedrestres
»( [ —
IS Edtvertees
Atbutes
< . X
W 1hom
E= | Goutofsseecteq) &
Frepaint | Frepont B ] M

aanBDBEE B8 dEBaey

Drawng - K () & - A - 2 |[@lmal S e ulA--2-
933026,85 4522724.995 Meters
Drsar| @ [[@7 | | 0] & 5] Deskop (2 () [0 o) 7 1020A% B




image71.png
& Uni
Fle Edt View Bookmaks Insert Selecton Geoprocessing Customize Windows Help

Deds L B8 x| 2 |- 226 A BRSO Fe g iavs- R gHAT <1 A% @I HN H &

=181]

]
I NNach 2 D RANQ Ll e H-TIk@ 7B M RIEC oFg
O &7 SR FTPPLGIIaH 200 @ET . )
X
"OBJECTID | PTType | Poi ¥
y T e
2ot
- u o
- f
X
< : X
W fom
ES | Gostorssdec L
Frepaint | Frepont B ] L

Drawing~ K () & [ - A - < [[0) el “fo =B 1 ulA-D-2- aanEn BRR EBFE DdERME Y

933804,284 4522803.987 Meters

Drsar| @ [[@7 | | 0] & 5] Deskop (2 () [0 o] (7 103444 B




image72.png
& Uni
Fle Edt View Bookmaks Insert Selecton Geoprocessing Customize Windows Help

D@8 L BB x| 9 b 225 A BRSO Fe g iavs- R gHAT <1 A% @I HN H &
Editor - [ ] M G- I N N th A 2 BRANQIII € K-TINIO 7B MHRIEE
O ED DB G T RPAR IS 2200 (WBRr e

r( oo e
]
’ Ll
&
)
X

|

=181]

(s

« ]

o 1o,

ES | Gostorssdec
Frepaint | Frepont B ] L
Draving - K () &l| O - A - 7< |[l0) el oo =B 7 Ul A->-2- aanEn BRR EBFE DdERME Y
sa810.24 4522814679 eters

Drsar| @ [[@7 | | 0] & 5] Deskop (2 () [0 o] 7 102354 B





image73.png
& & incident_data
{subject_directory]
& B backups
3 FeatureServices
(3 AGOL IMTservice YYYYMMDD_HHMM IncidentName IncidentNumber.gdb




image74.JPG




image75.JPG
@ £ AppData
& B Contacts
® £ Desktop
& £ Documents
5 B3 ArcGls
& B Addins
& B FeatureSenviceLocalEdits

Crescendo IMT_intermedia
it





image76.png




image77.png
New... CuleN b - 30000 v\;{\E-%.D ;,EQQ{"\O\::::H-'NW Oin@/fBISIABERE Q@B KP-LIRISTI® [
§' $220 01908 5o ®EE| 4@» b1 | PageTet~
¢ m., em‘en.m-ﬁ

YA

» >°>=\

D Map Package...
+ [ Tiepackage...
Signin.. @ Runtime
A Online.. Senice..

] | Creste s tile package from the
Page and Print Setup.. - | cuent mapipped up nto one
i, and either upload
itto ArcGIS Oniine orsave t o
disk Al package contains 3
cache of tlesthatyou can use 25 2

Seineed a0 B

RE CODEE
i
?

@alen

[ ) ) [ e[y ewing- K () 8O- A - < @A W B UA--geeo
529133 5358514053 Meters
500 A

4




image78.png
mierecizee T e SRR JICEE. . | WTTTER .

 oae Gfisr (8)

Tile Package: Tile Format
meremet | g scheme: [FvcSIS Onine /g Maps / Googe Maps -]
tem Desaipton
e Fomat:
Approximate Cache Size: 0Gb.
Levesofpetat

Choose the number ofevels to create for this tle package. - Allevels up to and inciuding the.
selected level wil be generated.

Fighest Level of Detai: of2





image79.JPG
Build your Favorites list now

E 7‘& To add an item to your favorites, just click the star. To

remove It, click the star again.

USA Population Density )





image10.JPG




image80.JPG
= 5 CollectorProjects.
Archive
CollectorPilot Worklow_Templates
) (£ 2014_GSTOP_Folder_Template
LayerFiles
ools
@ £ Tutorials.
& 3 VYWY IncidentName IncidentNumber OTHER Arc10.gdb
] AGOL IMTsenvice YVY_IncidentName IncidentNurmbersd
@] AGOLIMTsenvice YYVY_IncidentName IncidentNurmber.md
] AGOL_PUBLICsenvce YVYY IncdentName IncdentNumbersd
@] AGOL_PUBLICsenvice Y¥YY IncidentName IncdentNumbermxd
Workflow-12paf
Workflow - FlowChart pdf





image81.JPG
5 (3 Template Other.gdb.
® B incdent
G Rdata
9 Other
Labels
3 OtherPoints
@ OtherPolygon
5 Rehablines
(] RehabPoints
Structures
@R
PhotoPoint MapNotes
PhotoPoint, MapNotes_ATTACH
B PhotoPoint_ MapNotes_ATTACHREL
Structures_ATTACH
B Structures_ATTACHREL





image82.JPG
8e82
5 5 Layers
Labels
PhotoPoint MapNotes

3

OtherPoints
Proposed Point
Delete this Point

3 conrerors

[ Property-Other

[ Proverty-Pump

[ Property-Tonk

[~
K e

Otherpotgon
[ T I
W Evacuston- Stage1
M Evacuaton- Stage 2
M Evacution- Stage3

El





image83.png
# Traige -NoThreat

1 Trage -TrreatDefensibe

# Triage -Trreat Non Defensbie

‘ >





image84.JPG
2015_Demo.

) 5 base data

documents
GOL Workflow-Templates
incident_data
) 5 [subject_directory]
backups
@ [ 20140609
= £ 20140610
3 AGOL_service 20150610 1400_Demo_ABC123456.db.
) 20140610_1002_FrePoint.shp
exports
final
aps
modifed_base_data
) £ progression
# 3 2014 Demo_ABCL23456 FIMTIO0HLgdb
® 3 2015 Demo_ABCL23456_Othergdb
3 Photooint_MapNotesgdb
products
projects
9 £ backups
@] AGOL_public_2015 Demo_ABCL23456.med
Q] AGOL_service 2015 Demo_ABCL2456.med
Q] bref_ansié_land 2015 Demo_ABC123456_FIMTIO00LLmed
Q] iap_11x17_fand_2015_Demo_ABC123456_FIMTI0001Lmxd
5 tools





image2.jpeg




image85.JPG




image3.jpeg




image86.JPG




image5.jpeg




image6.png




image11.png




image12.png




image13.jpeg




image14.png




image15.png




image16.png




image17.png




image18.png




image19.png




image20.png




image1.jpeg




image21.JPG




image22.jpeg




image23.JPG




image4.jpeg




image24.JPG




image25.JPG




image26.jpg




image27.JPG
documents
CollectorPilot Workflow Templates
incident_data

@ 3 [subject_directory]

& B backups

@ £ FeatureServices

moiied_base_data
progression
& 3 VYWY IncdentName ABCL234_FIMTI001Lgdb
& 3 VYW IncdentName_IncidentNumber_OTHER Arcl0.gdb
5 Raata
55 Other
= PhotoPoint Maphotes
PhotoPoin, MapNotes_ATTACH
PhotoPoint_ MapNotes_ATTACHREL
Structures_ATTACH
S Structures _ATTACHREL
] AGOL IMTsenvice YYVY_IncidentName IncidentNurbersd
8] AGOL_PUBLICsenvice YVYY_IncidentName IncdentNumbersd
& B3 products
projects
) £ backups
@] AGOLIMTsensice YYYY IncidentName IncidentNurmberg002.mc
@] AGOL_PUBLICsenvice YVYY_IncidentName IncdentNumbermxd
® B tools





image28.png
+ Add Item ~




image29.png
HEEBE 3
L2 KB tr2e 8

—

Page and Print Setup...
print...





image30.png




image31.png
@ v we i () OIS s o oyl Sy

Dedsa !

Editor~ | »

Table Of Contents

kee8

Fle Edit View Bookmarks

B % 0 o b TR CHEEEE0 aafe

Insert  Selection

FIMT Menu ~ w%,m@ &nz

Geoprocessing  Customize  Windows  Help.

%YW P @0

5 Layers

FIMT Layers
FirePoint

Fireline

FirePolygon

TRRI2

IR JsolatedHeats
IR IntenseHeatd

IR ScatteredHeat10
IR HeatPerimeterl1

RehabPoints15
RehabLinesl6.

AssignmentBreak

I

Blon

- | Drawing~ K (=)

aﬂe

BT
N £

Za s

Catalog
Gl @]

Locat

B AcOL_IMTservice _YYYY_IncidentiName Incidenttiumber.Fea' +

= £ Folder Connections A
[ £ ArcGIS Default Location

Addins

FeatureServiceL ocalEdits

& Packages

3 2014 Scensrio_ NPS00002_FIMTI0011.gdb

3 Defaultgdb

® Tooboxtbx

someog omeio B

CA\CollectorProjects

CADemo.

CAUsers\dtraver\Desktop

C:\Users\dtraver\Downloads.

E\

&) Toolbores

G Database Servers

E5 Database Connections

i 615 Servers

) &3 My Hosted Services (National Interagency Fire Center)

B AGOL IMTservice YYYY_IncidentName IncidentNumber
) AGOL_PUBLICsenvice 2015 Ashland_ABC4321

B ALL_EATHC Alfields

1B ALLWGS84_EdTrk AllFeldsON -

Catalog | FgSearch

O-A-i<@m <0 ~ssu B





image32.png
@1 i 9 - |7 Proposed Workilow -Integrating a FIMT gdb and AGOL-Collector - M c@x
R e o = ) i ey Home Inset Pagelayout References Maiings Review View Acrobat | Desion | Layout | & @
D26 BB x| b [las HEEEE g ‘"‘s'ﬁ“’ﬁ Header Row (@] First Column Dsnadng~ g
| » m/ A RN/ R ERIEY QQ{"IO\:::: i svmmne || O vomrow £ st conn - [

HOIEBDRS ORI IR LG K 2208 g T sandedrows [ sanded Colmns - Borders -
B[z Table Sty Options Table Styles
i g
£
H
8
X Updatingthe feature services; adding changes from ArcMap:
Zoom Tolayer Python script available to use with taskmanager: hitp:/ /blogs ssri.com/esri/arcgis/
Zoom To Make Visble o 2013/04/23/updating-arcgis-com-hosted feature-services-with-python/
Visble Scale Range: 3 > Add the changes that occurred in the FIMT,gd through ArcMap to the AGOL service.
Use Symbol Levels . Use the EditorDate to find the new changes.
Edit Features y
O save AsLayerFie...
@ Create Layer Pacage. > Copy & Paste as necessary. [Save]
——— | Create Local Copy for Editing > Synchronize Local Edits with Server.
[ Properts... > Re-publishing the hosted featureservice is buggy rightnow.
XIL _ Additional Informatio £
> ESRI Help for AGOL: doc.arcgs.com/en/arcgis-online/ise-maps/use mapshim
> Attachments workflow:
D. Attachments will only be enzbled on PhotoPaints, (2 GloballD fieldis
includedin this feature)
E. Howdo I download attachments out of AGOL? [ArcGIS for Desktop 10.2 2
=l will support "Creating a local copy” of the service that will also N
Bl | | contain the attachments. (ESRI Help)] .
{orawng~ K () 8- A - K\@ [0 B1ulA->- gi@gl Im
-12048080.621 3837408, 151 Meters. || Pagei17 0119 | Words:2462 | B |

frsae| €| &([@ | oW o

P18 ) [Pl G s:t5AM -‘




image33.png
1T - Arciiap
Fle Edt View Bookmaks Insert Selecton Geoprocessing Customize Windows Help

=IolXi| @ & 9 - & |5 Proposed Workflow - Integrating a FIMT gdb and AGOL-Callector - M,
Home | Insert Pageloyout References Mailings Review View Acrobat

e

Design

- 0@

B

DBESI LA x| |- [fam AEE@E piws ¥ [Coonoan - NI
s > Pl e AL NNt A/ 2 BEIER QAN B B = Bz u-sexx 3 B o Conne | aiing
OIS LGWI PG PLS Xap 22 S| A Z-Aca K x| 2R T | e s
E Clipboard s Font 0 Paragraph £l Styles &l
2 &
: -
g
3
XL Updatingthe feature services; adding changes from ArcMap:
Fythom seriptavallablefouse withtaskmanager: it/ logs st om s aregi/
2013103723/ updating ares-com:hsted eature services with python/
Zoom To Layer > Add the changes that occurred inthe FIMT.gdbthrough ArcMap to the AGOL service.
Zoom To Make Visble. | Use the EditorDafs to find the new changes.
Visible Scale Range: » #
Use Symbol Levels
Eatreare 5
Structures [ Save AsLayerFie...
OtherPoints | @) Create Layer Package...
Otapanan
Reata  |CF Propertes..
R ttedreat
s Scvonize Locl Edt with Servr
Rontsereat 5
R Seatedreat
- Figure 24: First you willCreate 2 local copy for editing.
= o
los|e 5 > Copy Paste sonecesary. 5evl =
m—koE\DAQ\I—_I@ vl—_ln,uu-c\- PHT &
-12046929.582 3835842.738 Meters. || Pagei17 0119 | Words:2479 | ¥ |
o|afQ~ | &|we <D o> o S| Deskon *[4 () [V ] @ st B




image34.png
A EEEE0
on 42| X B fo +2 20 B

Display or et the properties of this

- Risk... PWR_Commurnity]  map document, such as description,
author, redts, and speciy whether
disk-based data it uses wil be:
referenced by reative pathnames.





image35.png
Map Document Properties

==l

s

Tte: Inddent Name

Sunmary: Thisis the Fire Polygon for the 000X Incident.

Descripton: [ This s the Fire Polygon for the 00X Incdent.

Author: Jane Doe
Gredis:
T, Fre Mapoing
C:emp\Test.gdb. &)

[ Store relative pathnames to data sources

Thumbnal: Wake Thumbnail DEfeEe Thimaal
[ o ] o | mor |





image36.png




image37.png
K TestMTmd ArcMap M

View Bookmarks Inert Selecton Geoprocessng Customize Windows  Help.

et
New. ot
open... oo
Save colss

- [
QI8

S EEE B O e g iavs- [ g -1 /H/O\J»[QNE!:E\

IEpiaafei:

i 5% SR T Pa% X8

&= -0 k@7 @D
B @B T s

A1, EaEAlol

g

RE ®ODEH

Map Package...
BB riepackage...

Sian Out - deborahtraver_uildfre
ArcGIS Oriie.

Page and Print Setup...
PrintPrevien...

print...

Export Map..

Analyze Map...

Map Document Propertes..

1.C:\sers\Deb Trav... est_IMT.mxd

2. TEMPLATE-Incidentame_IMT...
3E:\DEBOMADmappin... Neon.mxd
. \TEMPLATE-Incidentame IMT...
. \TEMPLATE-Incidentame xit...
\TEMPLATE-Incidentame._Pho...
\TEMPLATE-Incidentame_Ms..
\TEMPLATE-Incidenthame_Publ.
\ForestFie_for_editing_Master.

4
5
s
7
s
s

Edt At

i orawng~ K () &I - A - < [0

Drsa| @ [@7

Service
Pubish tis map 25 3 service on the

disabled i you are currently in Layout

Jae| o

Bzl oo I8 1 ulA-P-B- -0 @@Wﬂ@@\@@\@@

el

58395267 5204410.679 Meters.

Desktop ? |2 () [ il (7 254pM HE




image38.png
bl 3 serviee]

 Save a service definiton fie

%

 Overrite an existng service:

Bbout sharing  service:





image39.png
Choose a connection

[My Hosted Services (wiidfre Response)

e





image40.png
e Editor

Capabilities
Choose the capabilties you wouid like enabled for this service:





image41.png
ervice Editor

(Connection: My Hosted ServicesService Name: test

Feature Access
[The REST URL wil be defined once the service & publshed

<There are no properties for tis capabilty>





image42.png
e Editor

Item Description

Summary (required):
[Enter summary descrption here.

[Enter description here. Don't forget to Use Tags.

Update missing metadata n document based on item desaription.





image43.png
e Editor

Sharing

Share your service with:
I widfire Response:
I Everyone (public)

Members of these groups:

B g Operations
Dégeo
01 &G viewsrs





image44.JPG
A, Medium




image45.JPG
€ High




image46.png
NEW 8 DEL

YYYY_IncidentName

+ Add Item ~ @ Create

A Title

AGOL_IMTservice_YYYY_IncidentName_IncidentNumber

AGOL_IMTservice_YYYY_IncidentName_IncidentNumber

esults

Type
Feature Layer

Service Definition




image47.png
M trbox () -deboreh x { [ AGOL Questions/ts= x { M inbox (2) -nomadm x { M tnbox (5) -deb.bige x | @My Content x5 hitps:/fwwm.roupe x { Q) CrossfithRG Online x ¥ [ merathonrainingac: x \__ QNISHIHEES
& - C # [ wildfire.maps.arcgis.com/home/content. html e
Apps 9 GoogleMaps [ Music () Craigsist CJRuN [JGIS [ GARDEN [JNOMAD [ Food [ Sundance @BAGOL 4 STAND (5 My Avaiable Groupons

rotders +dd tem @ create wap x Bcreate Laver &

5] - Tite Type Modified Shared
B New

© B\ AGOL FireLine_Symbology Features May 19,2014 Not Shared

deborahtraver_wildfire (H

= - 5 B crescendo_editeMT Features May 16, 2014 Group
& 2014_Crescendo
5 2014_ForestFire_MasterfIM [ Crescendo_EditFIMT Service Defintion May 16,2014 Not Shared
5 Gallery

© M Crescendo_MasterFIMT Features May 19,2014 Group
i Temp
5 Templates e Crescendo_MasterFIMT Service Defintion May 19,2014 Not Shared
«E——

5] EGItFIMT_for_AGOL Service Definition May 15,2014 Not Shared
Show

© B Forestfire EditFIMT Features May 19,2014 Not Shared
1 an
Maps © B ForestFire_MasterFIMT Features May 15,2014 Group
Layers

e ForestFire_MasterFIMT Service Defintion May 15,2014 Not Shared
Apps
Tools © B\ MASTEREGItFIMT_for_AGOL ] Features May 19,2014 Group
Fles View tem detals

© [E Proposed-New_FireLine_Symbology_Map Addto tiap May 19,2014 Group

Add to New Hap wih full eciting control
© M Tues_tempor Add o Newliap May 20,2014 Group
Open in ArcGIS For Desiop
=] Tues_tempo1 el May 20, 2014 Not Shared

B creode 226155159

Panagakos_Marathon...xsx

(8] 505tates Merathon 0...pef

6] 201405 Fres_CA_Dat...pdf





image48.png
@ MASTER EGIFIMT_for_AGO. x \_

€ = C A [ wildfire.maps.arcgis.com,
i s 20 Googeaps (] usc @) Craglst (R [ Gis (] GARDEN

HOME GALLERY MAP GROUPS MY CONTENT MY ORGANIZATI

ignment8reak, FirePoints, FireLine for the Editab
Features (Hosted) by deborahtraver_wildfire

Source: Feature Service
Last Modified: May 19, 2014

(0 ratings, 51 views)

[ Fscebook [ Tuiter

R © skare  / eom DELETE B MOVE

Description




image49.png
€ > C [ wildfire.maps.arcgis.com/home/item.htmi?id=8fa5bode0e04471f887dbaeab08714a7
sops 8 GoogleMaps (] Musc @) Cragsist (v (1 GIs (] GARDEN (] NOMAD (] Food [ Suncnce @BAGOL £ STAND (G My Avaiable Grougans

Title MASTER-EditFIMT for_AGOL

Summary jssignmentereak, FirePoints, FireLine for the Editable FIMT Layers in AGOL

[ Fscebook [ Tuiter

‘Click thumbnal to change image.

Description

BIUA-B-|= E|F- FE- F|Y D Font - | size -

Assignment8reak, FirePoints, FireLine for the EditFIMT sevice in AGOL - Under development.

This would be the feature service that would allow edits. Edits will not be allowed to the MasterFIMT service. Operations would be given permissions and this is the service that will
hold all of their additions/changes, attachments, etc.

This Master will be available to make copies from. A copy would be made for each incident and be named appropriately. *IncidentName_EditFIMT=

The service can be added to an ArcMap project daily and the FIMT.gdb can be edited while referencing this. Further instructions on this process are under development.





image50.JPG
Properties

e FIMT ] [Fire Mapping x| 4dd ta0(s

Credits I
Delete Protection [] Prevent this item from being accidentally deleted.
Extent Left:-180  Right: 180

e 2 SET EXTENT

%0

Top: 90  Bottor

Enable editing and allow editors to:
® Add, update, and delete features
© Update feature attributes only

© Add features only

Export Data [ Allow others to export to different formats.
sync Enable Sync (disconnected editing with synchronization).

Track Edits Keep track of who created and last updated features.
(] Editors can only update and delete the features they add.

AVE CANCEL




image7.png




image51.png
This map document is a template that will be used as the hosted feature service for incident data that can be viewed by

Layers

FirePoint

PhotoPoin|

IR _IsolatedHeat =
IR_IntenseHeat &
IR_ScatteredHeat [

IR_HeatPerimeter &

TRE

FirePolygon 1

Otherpolygon &1

RehabPoints &1

RehabLines &1

Properties

Shared with draver

Tags FIMT

Credits NPs

size 681K8

Delete protection  Disabled

Extent Left:-180  Right: 180
Top: 90 Bottom: -90

Editing Editors can add, update, and delete features.

Export Data Disabled

Sync Enabled

cident personnel.

Track Edits Tracking who created and last updated features.




image52.png




image53.JPG
[¥] Enable editing and allow editors to:
Add, update, and delete features
Update feature attributes only
Add features only

ExportData [ Allow others to export to different formats.

sync Enable Sync (disconnected e
Track Edits

g with synch
eep track of who created and last updated fe
] Editors can only update and delete the feat





image54.png




image55.png




image56.png




image57.png




image58.png
€ > C # [ wildfire.maps.arcgis.com/home/webmap/viewer.html?webmap=86cccc2368754104b27fC
i pps 2 Googeaps () tusc CIRN ([ Gis (3 GAROEN (3 NoMAD (3 Food (] Sundonce @ AGOL 4 sTAND. O GFIRG

Share

Choose who can view this map.

Your map is currently shared with these people.

[] Everyone (public)
[] wildfire Response.

Members of these groups
0 GIss
¢ Operations

orio
L Viewers

Link to this map
http://bithy/ieNand ] [ Facebook [ Twitter
Embed this map

MAKE A WEB APPLICATION

Note: To embed your map, you must share it with Everyone.





image59.png
Apps 28 GoogleMaps (I Music (CJRuN (JGIS (] GARDEN () NOMAD (] Food () Sundance

Properties
g

Credits [

Delete Protection  [] prevent this item from being accidentally deleted.
Savehs Allow others to save a copy of this item.
Offine Mode Enable offine mode.
Extent Left:-141.19  Right: -49.25
Top: 5368  Bottom: 18.45

Application Settings  Select the tools and capabilties to enable in applications that access this web n

Routing

Measure Tool
Basemap Selector
Find Locations [-]

Hint text place or Address
[ By Layer

By Address

‘! 20140623_15%14 peg Marathon Trading Formisx  ~





image8.png




image60.png




image61.png




image62.JPG
@ Refesh layer every 0.1 minutes.




image63.png
Share as Senice AL N

Bbout sharing  service:





image64.png
Overwrite an Existing Service. L N

Choosea comecton

[y Hosted Services (atonal Interagency Fre Center) -)&
servce sevceroder st

| e ]
Eiscenaroot sevaned iy

=] Pubiched

EAcoL UL ICrvice_2015 s, iy

[ soant et iy

AL pipiids iy
Estcon Fodites iy

<oic [ Coniue ] [_cancel





image65.png
Qe i L -

File Edit View Bookmarks

=11

88

Insert  Selection

Geoprocessing  Customize  Windows  Help.

LER XD o b 140
W %

[

S

‘Ashland:ABC:4321

« (™) ’

5 i Drawing~ R (=) & O~ A

FEEEREE &K
NGV P RPAR X8y 02019
g Q= AN HH
Catalog
-l @]
Location: [ My Hosted Services. -

Home - Documents\ArcGIS
Folder Connections
& Toolboxes
G Database Servers
E5l Database Connections
65 Servers
) & My Hosted Services (National Interagency Fire Center)
B AGOL IMTservice YYYY_IncidentName IncidentNumber
B ALL\WGSB4_EdTrk AlFieldsON
B StCroix Facilties

Ready-To-Use Services (Notional Interagency Fire Center)

Catalog | FgSearch

someeg e B





image66.png
Locaton: |5 TEHPLATE Inodentome b reat |

i oIS Servers N
My Hosted Services (Wildfire Response)
& e
B e Locatontrackng
5 Sune_Protpants
5 e pusic
[T e——
(5, v aTe acentame. proports
& TevPLATE Jncentiame Pubic A
5

T —





image67.png
Untitled - ArcMap
Fle Edt View Bookmarks Insert Selectn Geoprocessing Customize

Windows  Help

DBE& L AR x| 9 o b [3e7

S EEE B O e g iavs- [k g 1 /H/O\J»[QNE!:E\

=18l x|

DN P S e LT PECE L I LI UV BRI
o] BT O XD 2% O I FPLD IS 20 9B T s
% New Incident B[
6 OpenIncdent S ML RS
(47 Switch Incdent
& SHAPE® | _unit 1D PTiype Pointame.
o Fom (0P [Camp Spie2 m

Pomt_[0pr[camp Spike 1 m
o [Foit D-PF__[Drop Pomt oP-1 un
i [Point. |ID-PF |Water Source: |Water Source: [un
o Pomt [0 [omer Vetici Tum Around__[un

Point_[D-PF [ obie Wealher Uni Raws m o
9 P [oPr [spotrre m
& Pom_[oPr [spotrre m
= Point_ [0 [spotFire m
=) [Point D-PF [Spot Fire [un
& [Point. |ID-PF |Spot Fire. [un

Pomt [0 [edvacsie iedvac m

Pomt [0 [omer Veticie Tur Around__[un

Pomt_[opr[camp Spikes m

Pomt_[oPr[singSie m

Poimt [0 [mespot m

Pomt_[0-PF[Lookout m

Pomt__[0-PF[Lookout m

Pom (0P Joump m

ot [DpF_[Water Source Dp Ste 1 m

Pomt_[opr[camp Spike ¢ m

[Point__[0-PF [ ioident Command Post | Crescendo 7 m

o [oPr [spotrre m

Pomt [0 [rorspot m

Pot_[DPF[Hot spot m

Pomt_—[0-PF[Lookout [idge Logkout n

« 4|
"o« 1+ » |[E]S | ©outof 26 selected)
it | FirePoint | =R 1|
 orawing~ K () 81| (] - A - < [[0) el f Fle 1 ulA-> -2 -0 BQATEDEH BB B SN 8 g

Drsa| @ [[@7 | W[ 0] 2|

Desttop (7 () [5 o] () 10940 B




image68.png
| EEEBOIp A ORI A QM AN G
CRNK*TEHHE LA E\No’\ LMK TR seeng-[O]8 0 7 g
L IR L X L T
[
e 1
Torset oSt <t
Notset Notset <k
Notset Notset <k o
Notset Notset <k
Nt set——|totset [k ||
Notset —Notset |t nl
&k
J
« 2l
W 10 0 B2 osofesdecsd) &l
FirePoint |iFepoint] (EIES o |
 orawing~ K () 81| (] - A - < [[0) el oo =B 1 ulA->- BINE 0 EHE @S \é‘x‘g@a

Number of features selected: 6

Drsar| @ [[@7 | | 0] & 5]

Desktop 7 (2 ) [V ol B 10:17AM B




